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1 About Admin Report Kit for SharePoint 

(ARKSP)  

 

Admin Report Kit for SharePoint (ARKSP) is a powerful configuration and usage 

reporting tool for Microsoft SharePoint Server 2010. ARKSP presents information across 

web applications, sites, site collection and lists in SharePoint in a simple report format.   

ARKSP collects configuration information about Windows SharePoint Services, Sites, Site 

Collection, Web and List Configuration and List Details etc. and reports them in a format 

for use by SharePoint Administrators. ARKSP also presents the usage information about 

site collection and list items.  

 

1.1 Who can Use ARKSP? 

Organizations running Microsoft SharePoint Server 2010 can greatly benefit from 

ARKSP. It is a powerful reporting tool collects configuration information about Windows 

SharePoint Services, Sites, Site Collection, Web and List Configuration and List Details 

etc. and reports them in a format for use by SharePoint Administrators. 
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1.2 System Requirements 

Processor Intel Pentium processor 

Disk Space 20 MB of free disk space 

Operating System Windows Server 2008 with .NET 

Framework 3.5 or higher with the 

latest service packs. 

Software Microsoft SharePoint Server 2010 

(or) Microsoft SharePoint 

Foundation 2010, with latest 

Service Pack. Microsoft Data 

Access Components (MDAC) 

v2.8 only. Microsoft SQL Server 

2008 (Enterprise / Standard / 

Developer / Express edition) or 

Microsoft SQL Server 2005 

(Enterprise / Standard / Developer 

/ Express edition) running in local 

/ remote computer with latest 

Service Pack. 

 

 

NOTE: ARKSP must be installed in the web front-end server / application 

server in the SharePoint farm. 
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1.3 How to activate the software? 

Once you purchase the software online or through any one of our resellers, you will 

receive a sale notification through e-mail from our sales department. We will send you 

an e-mail with the necessary instructions to activate the software. 

In case you do not receive an e-mail from our sales team after you purchase the 

software, please send the following information to our sales department at 

sales@vyapin.com with the sales order number: 

 Company Name: End-user Company Name 

 Location: City & Country for the Company Name given above 

Please allow 12 to 24 hours from the time of purchase for our sales department to 

process your orders. 

 

Image 1 - Activate screen 

Perform the following steps to activate the software: 

1. Download evaluation/trial copy of software from the respective product page 

available in our website at http://www.vyapin.com/ 

2. Install the software on the desired computer. 

3. You will receive a license key through e-mail as soon as the purchase process is 

complete. 

4. Click 'Activate' in Help -> About -> Activate menu to see the Activate dialog (as 

shown in Image 1). 
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5. Copy the license key sent to you through email, and pastes it in the 'License Key' 

textbox. For help on how to copy the license key, click 'Click here to see how to 

copy and paste the license key' link in the Activate dialog (as shown in Image 2). 

 

Image 2 - How to copy license key screen 
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2 ARKSP Reports 

 

2.1 Web Application Reports   

ARK for SharePoint 2010 provides the following built-in reports in the web application 

reports category: 

Report Name Description Fields 

Alternate Access 

Mappings 

Displays the public URLs from 

Alternate Access Mappings 

Configured in the web 

application 

Web Application, Internal URL, 

URL Zone, Public URL for Zone 

Alternate Access 

Mappings - 

External Resource 

Displays the public URLs from 

Alternate Access Mappings 

Configured in the external 

Web Application 

Web Application, Internal URL, 

URL Zone, Public URL for Zone 

Authentication 

Providers 

Displays the Authentication 

Providers configured in the 

Web Application 

Web Application, Zone, Allow 

Anonymous, Authentication 

Mode, Allow Client Object Model 

Requires Use RemoteAPIs 

Permission, Enable Client 

Integration| Disable Kerberos, 

Allow Use Basic Authentication 

Blocked File Types Displays the list of blocked file 

extensions configured in the 

web application 

Web Application, Blocked File 

Types 

Content 

Databases 

Displays properties of the 

content databases in each web 

application 

Web Application, Database 

Name, Database Status, 

Database Server, Current 

Number of Sites, Site Level 

Warning, Maximum Number of 

Sites, Disk Size Required For 

Backup (in MB) 

Data Retrieval 

Settings 

Displays information about 

data retrieval settings such as 

data retrieval services, limit 

response size, data source 

timeout etc. 

Web Application, Inherit Central 

Administration Application 

Settings, Data Retrieval 

Services, Limit Response Size 

(in KB), Data Source Time-out 

(in seconds), Services Enabled, 

Update Support Enabled 
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Farm Features Displays farm activated 

features and its dependency 

details 

Feature Name, Feature Folder 

Name, Description, Action 

Dependency Feature, Hidden, 

Version 

Page Visits Displays information about all 

the pages that are visited in 

the web application 

Web Application, Site URL, Page 

URL, User, Client IP Address, 

Visited Date 

Self Service Site 

Management 

Displays information about 

self service site creation 

settings for each web 

application 

Web Application, Self Service 

Site Creation Enabled, Require 

Secondary Contact 

SandBoxed 

Solutions 

Displays the solution's 

resource usage and its status 

details 

Web Application, Site Collection 

URL, Solution Name, Solution 

Id, Solution Status, Total 

Average Resource Usage(Last 

14 days), Total Current 

Resource Usage(Today) 

Site Collection 

Administrators 

Displays information about the 

site collection administrators 

configured for the site 

collections 

Web Application, Site Collection 

URL , Created Date, Primary 

Administrator, Primary 

Administrator Login Name, 

Primary Administrator E-Mail, 

Secondary Administrator, 

Secondary Administrator Login 

Name, Secondary Administrator 

E-Mail 

Site Collection 

Features 

Displays information about 

activated features and its 

dependency details in site 

collections 

Web Application, Site URL, 

Feature Name, Feature Folder 

Name, Description, Action 

Dependency Feature, Hidden 

Site Collection 

Quotas and Locks 

Displays information about the 

site collection storage settings 

and lock settings 

Web Application, Site URL, 

Owner Login Name, Quota 

Template, Storage Maximum 

Level (in MB), Current Storage 

Used (in MB), Storage Warning 

Level (in MB), Read Locked, 

Write Locked 

Site Collection 

Summary 

Displays site collection 

information such as site URL, 

owner name, email etc. 

Web Application, Site URL, 

Created Date, Last Item 

Modified Date, Last Content 

Modified Date, Last Security 

Modified Date, Primary Owner 

Name, Primary Owner Display 

Name, Primary Owner E-Mail, 

Secondary Owner Name, 

Secondary Owner Display 

Name, Secondary Owner E-Mail, 

Number of Sub webs, Number 

of Users, Number of Groups, 

Number of Alerts 

Site Collection 

Workflow 

Templates 

Displays information about the 

workflow templates configured 

in each site collection 

Web Application, Site URL, 

Workflow Template Name, 

Description, Associations, In 

Progress, Permissions 
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Web Application 

E-Mail Settings 

Displays information about the 

e-mail settings for the web 

application 

Web Application, From Address, 

Reply To Address, Outbound 

SMTP Server 

Web Application 

General Settings 

Displays web application 

general settings information 

such as default time zone, 

default quota template, 

maximum number of alerts 

etc. 

Web Application, Default Time 

Zone, Default Quota Template, 

Presence Enabled, Maximum 

Upload Size (in MB), Alerts 

Enabled, Alerts Limited, 

Maximum Alerts, RSS Feeds 

Enabled, Blog API Enabled, Blog 

API Authentication Enabled, 

Security Validation Enabled, 

Security Validation Expires, 

Security Validation Timeout (in 

minutes), Send Login 

Credentials By E-Mail, Event 

Handlers Enabled, Delete Log 

Entries, Log Retention Period (in 

days), Recycle Bin Enabled, 

Recycle Bin Cleanup Enabled, 

Recycle Bin Retention Period (in 

days), Second Stage Recycle 

Bin Quota (in percentage) 

Web Application 

Summary 

Displays web application 

information such as 

application pool name, content 

database, version etc. 

Web Application, Version, Host 

Name, Port Number, Zone, 

Allow Anonymous, 

Authentication Mode, 

Authentication Provider, Use 

Secure Sockets Layer, 

Application Pool Name, 

Application Pool Status, Identity 

Type, User Name, Number of 

Content Databases, Content 

Databases 

Web Application 

Use Confirmation 

and Deletion 

Displays information about the 

confirmation and deletion 

settings for unused web site 

collections 

Web Application, Send Unused 

Site Collection E-Mail 

Notification, Send Notifications 

After (in days), Unconfirmed 

Site Collection Deletion Enabled, 

Number of Notifications Before 

Deletion 

Web Application 

User Permissions 

Displays user permissions 

defined for each web 

application 

Web Application, User 

Permissions 

Web Part Pages 

Security 

Displays security information 

for web parts and web part 

pages in each web application 

Web Application, Allow Web 

Parts To Communicate, Allow 

Access To Web Part Catalog 
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2.2 Site Reports 

ARK for SharePoint 2010 provides the following built-in reports in the site reports 

category: 

Report Name Description Fields 

Alerts Displays information about all the 

alerts created for notifying the 

changes 

Web URL, Web Title, List 

URL, List Name, Item 

Name, Alert Title, Owner, 

Set for, Alert Type, Alert 

Filter, Alert Frequency, 

Alert Status, Email 

Recipient, Alert Day, Alert 

Time 

Audit - Deleted 

Lists 

Audit report displays the deleted 

lists in each site in the last 'N' 

days or for the given date range 

Web URL, Web Title, List 

URL, Occurred, Performed 

By 

Audit - Deleted 

Sites 

Audit report displays the deleted 

sites in the last 'N' days or for the 

given date range 

Web URL, Web Title, Site 

Name, Occurred, 

Performed By 

Audit - Group 

Member Added 

Audit report displays the list of 

newly added members in a Group 

in the last 'N' days or for the 

given date range 

Web URL, Web Title, User 

Name, Group Name, 

Occurred, Performed By 

Audit - Group 

Member Deleted 

Audit report displays the list of 

deleted members from a Group in 

the last 'N' days or for the given 

date range 

Web URL, Web Title, User 

Name, Group Name, 

Occurred, Performed By 

Audit - Page Visits Audit report displays the web 

pages visited in each site in the 

last 'N' days or for the given date 

range 

Web URL, Web Title, Page 

URL, Occurred, Performed 

By 

Audit - Permission 

Level Changes 

Audit report displays permission 

levels changed in each site in the 

last 'N' days or for the given date 

range 

Web URL, Web Title, 

Event, Permission Level 

ID, Permission Level, Old 

Base Permissions, New 

Base Permissions, 

Occurred, Performed By 

Audit - Permission 

Changes 

Audit report displays the 

permission changes performed in 

Groups/Users in each site in the 

last 'N' days or for the given date 

range 

Audit URL, Event , 

Group/Users ID, 

Groups/Users, Old 

Permission, New 

Permission, Changes in 

Permission, Occurred, 

Performed By 

Audit – Search Audit report displays the search 

queries and scope used in each 

site in the last 'N' days or for the 

given date range 

Web URL, Web Title, 

Query, Search Scope, 

Occurred, Performed By 

List Templates Displays information about all the 

list templates available in the site 

Web URL, Web Title, List 

Template, Internal Name, 

Description, Document 

Template, Type, Base 
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Type, Category Type, On 

Quick Launch, Is Custom 

Template 

Invited Users - 

Feature Status 

Displays all invited users to the 

site and their permissions, 

activation status for SharePoint 

Enterprise Site Collection feature 

and Enterprise Site feature 

Web URL, Web Title, 

Enterprise Site Collection 

Features, Enterprise Site 

Features, Account Display 

Name, Account Name, 

Account Type, Permission 

Levels 

Page Hits Displays the number of times a 

web page has been visited in each 

site 

Web URL, Web Title, File 

URL, Total Hits, Recent 

Month Hits, Recent Day, 

Recent Day Hits 

Page Hits - Monthly 

Usage 

Displays the number of times a 

page in a site has been visited in 

a given month range or all 

months in the last 31 months 

along with last accessed date 

Web URL, Web Title, Page 

URL, Last Accessed Date, 

Total Hits, Month1, 

Month2,....., Month31 

Recycle Bin 

Summary 

Displays recycle bin summary 

information like total number of 

items, last deleted date, total size 

of deleted item etc. 

Web URL, Web Title, Last 

Item Deleted Date, Last 

Item Deleted By, Total 

size (in MB) 

Site Columns Displays all the site columns that 

are available in the site 

Web URL, Web Title, 

Column Name, Type, Type 

Display Name, Group, 

Description, Required 

Site Content Types Displays all the site content types 

that are available in the site 

Web URL, Web Title, 

Content Type, Description, 

Group, Document 

Template, Document 

Template URL, Read Only 

Site Features Displays information about 

activated features and its 

dependency details in each site 

Web URL, Web Title, 

Feature Name, Feature 

Folder Name, Description, 

Action Dependency 

Feature, Hidden 

Site Hits Summary Displays a summary of site visits Web URL, Web Title, Total 

Hits, Recent Month Hits, 

Recent Day, Recent Day 

Hits 

Site Hits Summary 

- Monthly Usage 

Displays the number of times a 

site has been visited in a given 

month range or all months in the 

last 31 months 

Web URL, Web Title, Total 

Hits, Month1, Month2,....., 

Month31 

Site Group Settings Displays information about groups 

available in each site 

Web URL, Web Title, 

Group Name, Account 

Type, Inherit Permissions, 

View Membership, Edit 

Membership, Join/Leave 

Group, Auto Accept, 

Permission Levels 

Site Permission 

Levels 

Displays information about 

permission levels defined in each 

site 

Web URL, Web Title, 

Permission Level, 

Description, Permissions 
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Site Permissions Displays information about site 

permissions (groups and users) 

defined in each site 

Web URL, Web Title, 

Groups/Users, Account 

Type, Description, Group 

Owner, Permission Levels, 

Members 

Site Visitors Displays the number of times 

users have visited each site. 

Web URL, Web Title, User, 

Total Hits, Recent Month 

Hits, Recent Day, Recent 

Day Hits 

Site Visitors - 

Monthly Usage 

Displays the number of times an 

user has visited each site in a 

given month range or all months 

in the last 31 months along with 

last accessed date 

Web URL, Web Title, Site 

Visitors, Last Accessed 

Date, Total Hits, Month1, 

Month2,....., Month31 

Site Security Displays site security information 

like allow anonymous access, 

authentication mode etc. 

Web URL, Web Title, Allow 

Anonymous Access, 

Anonymous State, Allow 

Unsafe Updates, 

Authentication Mode, Has 

External Security Provider, 

Inherits Role Assignments, 

Inherits Role Definitions, 

Request Access Enabled, 

Request Access E-Mail 

Site Settings Displays site settings information 

like time zone, theme, template 

etc. 

Web URL, Web Title, 

Description, Time Zone, 

Theme, Template, Quick 

Launch Enabled, Tree View 

Enabled, RSS Enabled 

Site Summary Displays site summary 

information like author, created 

date, web size(in MB) and number 

of sub webs etc. 

Web URL, Web Title, 

Author, Created Date, Last 

Item Modified Date, Web 

Size (in MB), Number of 

Sub webs, Number of 

Users, Number of Groups, 

Number of Lists, Number 

of Alerts, Number of 

Content Types, Number of 

Site Columns 

Site Activity Displays the first and last activity 

performed on the SharePoint site 

for last 'N' days or for the given 

date range. 

Web URL, Web Title, First 

Activity Date, First Activity 

- User Name, First Activity 

- Transaction, Last Activity 

Date, Last Activity - User 

Name, Last Activity – 

Transaction 

Site Workflows Displays the information about 

workflows configured in each site 

Web URL, Web Title, 

Workflow Name, Initiator, 

Started On, Last Run, 

Workflow Status, Task 

Title, Task Assigned To, 

Due Date, Task Status, 

Outcome 

Web Pages Displays information about all the 

web pages that are available in 

each site 

Web URL, Web Title, Web 

Page Title, Web Page URL, 

Author, Web Part Title, 

Created On, Last Modified, 
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Page Size (in KB), Total 

Size (in KB) 

Web Parts Displays information all the web 

parts available in each site, user 

who created the web part etc. 

Web URL, Web Title, Web 

Part Title, Web Part Name, 

Parent Folder, Author, 

Created On, Last Modified, 

Size (in KB) 

Web Parts 

Utilization 

Displays information about 

utilization (size, used web pages, 

etc.) of all the web parts in the 

site's web part gallery 

Web URL, Web Title, Web 

Part Title, Web Part Name, 

Web Page Title, Web Page 

URL, Parent Folder, 

Author, Created On, Last 

Modified, Size (in KB) 
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2.3 List Reports 

ARK for SharePoint 2010 provides the following built-in reports in the list reports 

category: 

Report Name Description Report Fields 

Audit – Checked-

In Items 

Audit report displays the list items 

checked-in in the last 'N' days or 

for the given date range 

Web URL, Web Title, List 

Name, Item URL, Item type, 

Item Name, Occurred, 

Performed By 

Audit – Checked-

Out Items 

Audit report displays the list items 

checked-out in the last 'N' days or 

for the given date range 

Web URL, Web Title, List 

Name, Item URL, Item Type, 

Item Name, Occurred, 

Performed By 

Audit – Copied 

Items 

Audit report displays the list items 

that are copied to another location 

in the last 'N' days or for the given 

date range 

Web URL, Web Title, List 

Name, Source URL, Source 

Item Name,  Destination 

URL, Destination Item 

Name, Occurred, Performed 

By 

Audit – Deleted 

Items 

Audit report displays the list items 

deleted in the last 'N' days or for 

the given date range 

Web URL, Web Title, List 

Name, Item URL, Item Type, 

Item Name,  Occurred, 

Performed By 

Audit – Profile 

Changed 

Audit report displays the changes 

details about the content types in 

the connected list in the last 'N' 

days or for the given date range 

Web URL, Web Title, List 

Name, Content Type Name, 

Group Name, Performed On, 

Performed By 

Audit – Renamed 

Items 

Audit report displays the list items 

that are renamed in the last 'N' 

days or for the given date range 

Web URL, Web Title, List 

Name, Old Name, New 

Name, Occurred, Performed 

By 

Audit – Restored 

Items 

Audit report displays the list of 

items that are restored from the 

Recycle Bin in the last 'N' days or 

for the given date range 

Web URL, Web Title, List 

Name, Item URL, Item Type, 

Item Name Occurred, 

Performed By 

Audit – Updated 

Items 

Audit report displays the list items 

added or modified in the last 'N' 

days or for the given date range 

Web URL, Web Title, List 

Name, Item URL, Item Type, 

Item Name, Occurred, 

Performed By 

Audit – Visited 

Items 

Audit report displays the list items 

visited in the last 'N' days or for 

the given date range or for the 

given date range 

Web URL, Web Title, List 

Name, Item URL, Item Type, 

Item Name, Occurred, 

Performed By 

Checked Out 

Documents 

(Library only) 

Displays the list of documents that 

are checked out in a library 

Web URL, Web Title, Item 

URL, Created By, Created 

Date, Size (in MB), Checked 

Out By, Checked Out Date, 

Check Out Status 

File Types Displays the file types available in 

the document library 

Web URL, Web Title, Base 

Template, List Name, File 

Type, Count 

List Activity Displays the first and last activity 

performed on the list for last 'N' 

Web URL, Web Title, List 

URL, List Name, First 
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days or for the given date range Activity - Item Name, First 

Activity - Item URL, First 

Activity Date, First Activity - 

User Name, First Activity - 

Transaction, Last Activity - 

Item URL, Last Activity - 

Item Name, Last Activity 

Date, Last Activity - User 

Name, Last Activity – 

Transaction 

Last Modified 

Items 

Displays the list of items that are 

Modified in last 'N' days or for the 

given date range 

Web URL, Web Title, Item 

URL, Item Name, Modified 

By - User Name, Modified By 

- Display Name, Modified 

Date, Size (in MB)) 

Last Deleted 

Items 

Displays the list of items that are 

Deleted in last 'N' days or for the 

given date range 

Web URL, Web Title, Item 

URL, Item Name, Deleted By 

- User Name, Deleted By - 

Display Name, Deleted Date, 

Created By - User Name, 

Created Date, Last Modified 

By - User Name, Last 

Modified Date, Size (in MB) 

List Columns Displays all the columns available 

in the list 

Web URL, Web Title, Base 

Template, List Name, 

Column Name, Type, 

Description, Required 

List Folders 

Security 

Displays information about the 

Groups/Users and their 

permissions assigned to each 

folder and its sub-folders in the 

connected list. 

Web URL, Web Title, Base 

Template, List Name, Folder 

Name, Folder URL, 

Groups/Users, Permission 

Levels 

List General 

Settings 

Displays general settings 

information about the list such as 

versioning enabled, version limit, 

etc. 

Web URL, Web Title, Base 

Template, List Name, 

Description, Attachments  

Enabled, On Quick Launch 

Bar, Permission Inheritance, 

Versioning Enabled, Minor 

Versions Enabled, Folder 

Creation Enabled, RSS 

Enabled, Major Version 

Limit, Major With Minor 

Version Limit, Unique Role 

Assignments, Force Check 

Out, Allow Content Types, 

Allow Everyone To View 

Items 

List Hits Displays the information about 

number of times a list has been 

visited in the last 'N' days or for 

the given date range 

Web URL, Web Title, List 

Name, Total Hits, Recent 

Month Hits, Last Accessed 

Day, Last Accessed Day Hits 

 

List Hits - 

Monthly Usage 

 

Displays the information about 

number of times a list has been 

visited in the last 31 months or for 

the given date range 

 

Web URL, Web Title, List 

Name, Total Hits, Month1, 

Month2,......, Month31 

List Item Displays information about the Web URL, Web Title, Base 
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Security users and their permissions 

assigned to each list item 

Template, List Name, Item 

URL, Item Name, 

Groups/Users, Permission 

Levels 

List Item 

Summary 

Displays summary information 

about the list items such as 

created by, created date, size etc. 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Created 

By, Created Date, Modified 

By, Modified Date, Size (in 

MB) 

List Permissions Displays information about list 

permissions defined for each user / 

group 

Web URL, Web Title, Base 

Template, List Name, 

Groups/Users, Permission 

Levels 

List Summary Displays summary information 

about the list such as size, number 

of users, number of columns, etc. 

Web URL, Web Title, List 

Name, Base Template, 

Number of Columns, 

Number of Users, Number of 

Folders, Number of Items, 

List Size (in MB), Author, 

Created Date, Last Modified 

Date, Last Deleted Date 

List Visits Displays information about the list 

items that are accessed in last 'N' 

days or for the given date range 

Web URL, Web Title, List 

Name, Item URL, Item ID, 

Total Visit Count, Item 

Name, Item Visit URL, Visit 

Count, Action, Visited By, 

Visited Date, Visited Time 

List Workflow 

Settings 

Displays information about 

workflow details in the list 

Web URL, Web Title, Base 

Template, List Name, 

Workflow Template, 

Workflow Name, 

Description, Created Date, 

Modified Date, Task List, 

History List, Allow Manual 

Start, Auto Start Workflow 

On Item Creation, Auto Start 

Workflow On Item Change, 

Permissions 

List Workflow 

Status – 

Cancelled 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'Cancelled' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 

Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

List Workflow 

Status – 

Completed 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'Completed' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 

Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

List Workflow 

Status - Error 

Occurred 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'Error Occurred' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 
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Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

List Workflow 

Status – Failed 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'Failed' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 

Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

List Workflow 

Status - In 

Progress 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'In Progress' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 

Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

List Workflow 

Status - Not 

Started 

Displays workflow task details for 

each list item in the list, whose 

workflow status is 'Not Started' 

Web URL, Web Title, Base 

Template, List Name, Item 

URL, Item Name, Workflow 

Name, Initiator, Started On, 

Last Run, Task Title, Task 

Assigned To, Due Date, Task 

Status, Outcome 

Newly Added 

Items 

Displays the list of items that are 

created in last 'N' days or for the 

given date range 

Web URL, Web Title, Item 

URL, Item Name, Created By 

- User Name, Created By - 

Display Name, Created 

Date, Size (in MB) 

Version History  Displays information about all the 

versions available for each 

file/item in the list. 

Item URL, Latest Version, 

Number of Versions, Created 

By, Created Date, Version 

ID, Modified By, Modified 

Date, Size (in MB), Changed 

Field, Changed Value 

 

 

 

 

 

 

 

2.4 Change Log Reports   
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Change Log Reports display information about the newly added, last modified and last 

deleted items in a SharePoint list (library, default built-in list or custom list) for a period 

of last N days or for the number of days in a data range. ARKSP retrieves change 

information using SharePoint objects from the content database to present the reports to 

the user. 

ARKSP generates this report for the number of the days configured in Change Log 

setting in SharePoint Central Administration site. By default, SharePoint retrieves change 

log data for 15 days. 

ARKSP can generate change log based reports for the maximum duration (days) the 

change log data is maintained in the content database. The last date from which log data 

is maintained in the content database can be determined as follows: [Last run time of 

the timer job corresponding to the web application - Number of days in Change Log 

retention settings] 

You can view the last run time of timer job by clicking on the Change Log job 

corresponding to the destination web application using [Central Administration > 

Operations > Timer Job Definitions] link in SharePoint Central Administration site. 

You can view the status, progress, start time and server of the Change Log job using 

[Central Administration > Operations > Timer Job Status] link in SharePoint Central 

Administration site. 

You can view / modify the scheduled run time of the Change log job using the command 

line SharePoint Administration Tool (stsadm.exe) as shown in the article mentioned 

below: 

Windows SharePoint Services - Job-change-log-expiration: Stsadm property 

http://technet.microsoft.com/en-us/library/cc424964.aspx  

Office SharePoint Server - Job-change-log-expiration: Stsadm property 

http://technet.microsoft.com/en-us/library/cc424949.aspx 

Please read the information given below to view the reports that are based on change 

log information. 

 

 

Report Category Report Name Description 
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List Newly Added Items Displays the list of items that are created 

in last 'N' days or for the given date 

range. 

List Last Modified Items Displays the list of items that are 

Modified in last 'N' days or for the given 

date range. 

List Last Deleted Items Displays the list of items that are Deleted 

in last 'N' days or for the given date 

range. 

List List Activity Displays the first and last activity 

performed on the list for last 'N' days or 

for the given date range. 

Site Site Activity Displays the first and last activity 

performed on the SharePoint site for last 

'N' days or for the given date range. 

 

 

 

 

 

 

 

 

 

 

2.5 Usage Analysis Reports    



CHAPTER 2 – ARKSP Reports 

18 

Usage analysis reports display detailed information about usage of Sites and Lists in a 

SharePoint server. ARKSP gathers usage information from STS and IIS log files to 

present the reports to the user. Please read the information given below to view the 

reports that are based on log files.  

ARKSP collects information from STS log files for the reports stated below. These 

reports require STS logging to be enabled to generate the report. Enable the "Enable 

Logging" and "Enable usage analysis processing" options in the "Usage Analysis 

Processing" section in SharePoint Central Administration.  

Report 

Category 

Report Name Description 

Site Page Hits Displays the number of times a web page 

has been visited in each site. 

Site Page Hits-Monthly 

Usage 

Displays the number of times a page in a 

site has been visited in a given month range 

or all months in the last 31 months along 

with last accessed date. 

Site Site Visitors Displays the number of times users have 

visited each site. 

Site Site Visitors-Monthly 

Usage 

Displays the number of times an user has 

visited each site in a given month range or 

all months in the last 31 months along with 

last accessed date. 

Site Site Hits Summary Displays a summary of site visits. 

Site Site Hits Summary 

Monthly Usage 

Displays the number of times a site has 

been visited in a given month range or all 

months in the last 31 months 

List List Hits Displays the information about number of 

times a list has been visited in the last 'N' 

days 

List List Hits Monthly Usage Displays the number of times a list has been 

visited in a given month range or all months 

in the last 31 months. 
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ARKSP collects information from IIS log files for the reports stated below. These 

reports require IIS logging to be enabled to generate the report. Enable the "Enable 

Logging" option in IIS for the web application. 

Report Category Report Name Description 

Web Application Page Visits Displays information about all the pages 

that are visited in the web application 

List List Visits Displays information about the list items 

that are accessed in last 'N' days 

The above mentioned IIS log files based reports require IIS Log Files Directory to be 

configured to process IIS log file data and generate the reports successfully. 

NOTE: If you are running ARKSP on Windows Server 2008, please ensure 

'ODBC Logging' is installed on the server to generate the above mentioned IIS 

reports successfully. 

Steps to verify whether 'ODBC Logging' is installed on the server: 

1) In ARKSP installed server, click Start, point to Administrative Tools, and then click 

Server Manager.  

2) In the Server Manager Hierarchy pane, expand Roles, and then click Web Server 

(IIS).  

3) In the Web Server (IIS) pane, scroll to the Role Services section.  

4) On the Role Services page, ensure ODBC Logging (available under Health and 

Diagnostics node) is checked.  

5) On the Role Services page, click Cancel. 

If 'ODBC Logging' is not installed on the server, please perform the steps to install it on 

the server:  

1) In ARKSP installed server, click Start, point to Administrative Tools, and then click 

Server Manager.  

2) In the Server Manager Hierarchy pane, expand Roles, and then click Web Server 

(IIS).  

3) In the Web Server (IIS) pane, scroll to the Role Services section, and then click 

Add Role Services.  
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4) On the Select Role Services page of the Add Role Services Wizard, select ODBC 

Logging (available under Health and Diagnostics node).  

5) On the Select Role Services page, click next.  

6) On the Confirm Installation Selections page, click Install.  

7) On the Results page, click Close. 

 

 

2.6 Audit Reports 

ARKSP provides Audit Reports across Site Collections and Lists. You have to enable 

audit settings in Microsoft SharePoint Server 2010 to view the reports in ARKSP. Please 

follow the instructions given below to enable the audit settings. 

a) How to configure audit settings in Microsoft SharePoint Server 2010? 

Click the link below to view the detailed information about how to configure audit 

settings in Microsoft SharePoint Server 2010. 

http://office.microsoft.com/en-us/sharepoint-server-help/configure-audit-settings-for-a-

site-collection-HA010099726.aspx?pid=CH101237681033 

You can also configure audit settings in Microsoft SharePoint Server 2010 using 'Audit 

Settings Manager' in ARKSP. 
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2.7 Audit Settings 

In Tools menu, click ARKSP Settings->Audit Settings node. Audit Settings Manager 

dialog will be displayed as shown below: 

 

Click Added URLs tab to add site collection URL(s) and specify the events that should be 

audited for documents, items, lists, libraries, and sites within the site collection. 
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Click Configured URLs tab to view the site collection URL(s) and its audit events that are 

already set using ARKSP. 
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To add the site collection URL, 

1) Enter a valid site collection URL and click Add (or) Click 'Browse...' button to 

choose URL(s). This will display a window as shown below: 

 

 

2) To remove a site collection URL, select the URL from the URL list box and Click 

Remove button to remove the selected URL.  

3) Click OK button to configure the audit events for the selected site collection 

URL(s). 
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3 
3 Using ARKSP 

3.1 How to get started with ARKSP? 

Before beginning to use ARK for SharePoint 2010 to generate reports, you must 

enable a few settings and configure the application database as outlined below: 

SharePoint Settings 

1) SharePoint user permissions - ARKSP uses the currently logged on user 

account while running Quick Reports (under interactive mode) and uses 'Run As' 

account while running Power Reports task (run as a scheduled task or using Run 

Now option) to generate the corresponding reports. 

ARKSP requires the above mentioned user account to be: 

a) Member of administrators group in SharePoint Server and Database Server [This 

will be useful if you are generating reports for multiple SharePoint sites residing 

in different web applications]  

(OR) 

b) Application pool user account of a web application [This will be useful if you are 

generating reports for a single web application hosting the SharePoint site] 

(OR) 

c) Farm Administrators group of the SharePoint farm 

Recommendation: It may be of help to use a domain admin account who is 

member of administrators group in SharePoint and the SQL Servers to generate the 

SharePoint reports for all web applications seamlessly. 

2) Audit Settings - ARKSP provides Audit Reports across Site Collections and Lists 

available in SharePoint web application. You have to enable audit settings in 

Microsoft SharePoint Server 2010 to view these reports in ARKSP. 
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3) Usage Analysis Settings - ARKSP presents usage information about various 

SharePoint objects namely, web application, site and list item as recorded in the 

STS / IIS log files. In order to generate these reports successfully, you need to 

enable STS / IIS logging in SharePoint and IIS respectively. 

SQL Server Settings 

ARKSP uses SQL Server database for its data storage to generate SharePoint reports. 

ARKSP requires SQL Server 2005 or SQL Server 2008 (Enterprise / Standard / Express 

editions) to connect and create a database. ARKSP will connect to the specified SQL 

Server based on the authentication mode and user credential to manage its own 

application databases. You have to specify the suitable SQL Server settings in ARKSP to 

view these reports in ARKSP. 

ARKSP uses the USER ACCOUNT based on the SQL authentication mode set in SQL 

Server settings in ARKSP to create database and store report data. 

The USER ACCOUNT denotes the currently logged on user account while running Quick 

Reports (under interactive mode) and denotes the 'Run As' account while running Power 

Reports task (run as a scheduled task or using Run Now option). You can also use an 

exclusive SQL user account to create and manage its own application database. Please 

note that ARKSP requires the USER ACCOUNT to have sufficient privileges to create, add 

and delete database in the SQL server. 

ARKSP Features 

ARKSP features are broadly classified as follows: 

A. Quick Reports - Provides a set of SharePoint configuration, permissions, usage 

and audit reports for web application, site collection, site and list and their items. 

This task option is ideally suited for quick glance of the current SharePoint 

information. 

B. Custom Reports - Facilitates customizing ARKSP's Quick Reports output by 

selecting the desired fields and their field order. 

C. Power Reports - The Power Reports uses 'Task' based approach that allows you 

to select multiple reports with customized (sub-set) fields, defines report criteria 

and schedule export of reports periodically. This feature will enable the user to 

export multiple reports for several sites / lists in SharePoint at periodic intervals. 
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3.2 ARKSP Settings 

ARKSP requires the following settings to be configured to generate reports. 

Settings Description 

SQL Server Settings ARKSP maintains its application database(s) in SQL 

Server. To create and maintain database in SQL Server, 

specify the SQL Server (Enterprise / Standard / 

Developer / Express edition) and authentication method. 

The user account specified must have sufficient privileges 

to create and delete the database in SQL Server. 

Directory Server Settings ARKSP uses the Directory Server to retrieve AD 

information like group membership, user information etc. 

Specify the Global Catalog Server for the Directory 

Server Name and the corresponding user credentials. 

E-mail Settings ARKSP will use the SMTP Server and From Address to e-

mail the reports to the respective recipients. 

IIS Log Files Directory ARKSP uses IIS log files for generating a few reports. 

Specify the IIS Log Files Directory for each front-end 

web server in the SharePoint farm to run such reports. 

Audit Settings Specify the events that should be audited for documents, 

Items, lists, libraries, and sites within the site collection. 

If you are enabling Audit for the first time, SharePoint 

will begin auditing the selected events from the 

configuration date/time. 

Profile Manager ARKSP can store your logon information for SharePoint 

sites using Windows Stored User Names and Passwords 

applet. The stored profiles will be used to connect to SQL 

Server when necessary. 
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3.3 Change Application Data folder location   

ARKSP enables you to change Application Data folder location, where its application 

settings and error log are stored, at any time after installing ARKSP software. To change 

the Application Data folder location, perform the following steps given below: 

1 Select About ... from Help menu 

 

2 The About ARKSP dialog appears as shown below: 

 

3 Click Change... button to change Application Data folder location of ARKSP 

application.  
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The „Browse For Folder‟ location dialog will appear as shown below: 

 

4 Select a desired folder location and Click OK. The folder location can be local 

drives or mapped network drives. 

5 ARKSP provides an option to copy or move the existing ARKSP application 

settings and error log to the new location once you change the Application Data 

Folder. Once you specify the new Application Data folder location, ARKSP will 

prompt you to copy or move existing ARKSP application settings to the new 

location as shown below: 

 

6 Click the desired action (Copy / Move / Close) to proceed. ARKSP will use the 

new Application Data folder location henceforth. 
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3.4 Task Status 

To view and manage task status of a selected task: 

1) Select Tools > Show Task Status from the main window or Click  

from Power Reports Actions Pane. 

2) The Task Status dialog appears as shown below : 

 

You can perform the following actions in the Task Status dialog: 

a) Show status for <n> days: Upon clicking Go button, displays task history 

entries of all tasks that were run within the specified number of days. 

b) Refresh: Reloads the task history entries and updates the newly run tasks (if 

any). 

c) View log file: Displays activity log of the currently selected task history item. 

d) Remove: Removes the currently selected task history entry and its 

associated log folders and files. 

e) Remove all: Removes all task history entries and their associated log folders 

and files that are currently displayed. 

3) Click Close button to close this window. 
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4 Quick Reports  

 

4.1 How to generate a Web Application Report? 

Web Application Reports 

Web application reports deal with providing information about the web application 

configured in SharePoint server. 

Click File -> Quick Reports to invoke ARKSP Quick Reports Wizard. 
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Perform the following steps to run a quick report under the Web Application category:  

1. Select a report and click Next button (when a report scope is applicable, 

otherwise click the Finish button). This will display a window as shown below: 

 

2. Choose a report scope: 

a) 'All web applications' - Collects the report data for all web applications 

configured in SharePoint  

b) 'Connected web application only' - Collects report data for the specified 

web applications only. 

3. Type a valid 'Web Application URL or Click  button to choose a web 

application. 

4. Click Finish button to view the selected report. 

 

 

 

 

 

 



CHAPTER 4–Quick Reports 
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4.2 How to generate a Site Report? 

Site Reports 

Site Reports provide useful configuration and usage information about the connected 

site. ARKSP provides not only currently connected site information, but also its sub-sites. 

1) Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 
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2) Select any desired report and Click Next button to continue. This will display a 

window as shown below: 

 

3) Select any of the following scopes for the report to be viewed: 

a) All sites in web application - If URL entered is a valid Web Application URL, 

ARKSP retrieves report information for all the sites, including sub-sites and  

top level sites, in the web application 

b) Connected site and its sub-sites - Retrieves report information for the 

connected site and its sub-sites  

c) Connected site only - Retrieves report information for the connected site 

only. 

4) By default, all sites in web application option will be selected. 

5) To connect to a particular site: 

a) Type full URL of the site in the format http://servername:port 

number/sitename (or) 
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b) Click  button to show the Select a SharePoint Site dialog as shown 

below. 

 

c) Select the required site and Click OK button. 

6) Click Finish button in the wizard to view the report. 
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4.3 How to generate a List Report? 

List Reports 

List report shows detailed information about all the list types such as document library, 

picture library, contacts etc., and this report provides configuration information, users, 

columns, and views information based on the scope and URL specified. 

For the Document Library, Picture Library, Form Library, ARKSP reports size of the list, 

number of folders and files, top folders and files in the list, file types present in the list 

such as DOC, XLS, HTML, PPT etc. 

Click File ->Quick Reports to invoke ARKSP Quick Reports Wizard. 

 

Select any desired report and click Next to continue. This will display a window as 

shown below: 
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Select any of the following scopes for the report to be viewed:  

a) All lists in the connected site and its sub-sites - If URL entered is a valid site 

URL, ARKSP retrieves report information for all lists in the connected site and its 

sub-sites.  

b) All lists in the connected site - Retrieves report information for all the lists in 

the connected site.  

c) Connected list only - Retrieves report information for the connected list only. 

By default, All lists in the connected site and its sub-sites option will be selected. 

To connect to a particular site or list:   

a) Type full URL of the site in the format http://servername:port number/sitename 

or http://servername:port number/sitename/listname for the scope option 

selected.  (or)  
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b) You can also click  button to show the Select a SharePoint List or Select a 

SharePoint Site dialog as shown below. 

 

When you select All lists in the connected site and its sub-sites or All lists in the 

connected site option, you may view the report data only for the lists that belongs to a 

particular list template (e.g. Document Library, Picture Library). 

Click Get List Templates button to enumerate all the lists that are available in the 

selected URL. By default, 'All' will be selected, which collects data for all the lists in the 

site. 

Click Finish button to view the report. 
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4.4 Custom View 

Click  button in the toolbar. Select the fields to view in the report.   

 

Click OK button to view the customized report data in the grid. 
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4.5 Find Data 

To search for data in a report, Click  button and just type the character(s) or words 

you want to find in the find edit box, available in the find window, and then Click the 

Find All button. 

 

You can use the "*" wildcard character in the search criteria. The "*" wildcard character 

acts as a place holder for zero or more characters. However, note that you cannot use 

the "?" wildcard character in the search criteria. 

For instance, if you want to search for 'URL' in a report, Type URL, without quotations, in 

the edit box, and then Click on Find Button. For all the matches found, ARKSP highlights 

the corresponding columns in the grid.   

NOTE: The search criteria should not be enclosed within quotation marks. 

The following table summarizes the behaviour of the find feature. 

john doe Searches the report for john doe followed by zero 

characters. 

*/default.aspx Searches the report for /default.aspx starting with zero or 

more characters and ending with zero characters 

*library* Searches the report for library starting with zero or more 

characters and ending with zero or more characters. 

Document 

Center* 

Searches the report for Document Center starting with zero 

characters and ending with zero or more characters.   
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4.6 Filter Data 

Click  button in the toolbar to specify the conditions for filtering report data. 

 

Select a field from the drop-down and specify the value for filtering the report data. 

Click OK button to view the data filtered report. 

 

4.7 Refresh Data 

ARKSP displays data from the local data store until the data is refreshed. 

To “Refresh” data, Click  button in the toolbar to recollect the data from the 

SharePoint again. 

NOTE: Once you closed the report window and generate the same report again, 

ARKSP collects the fresh data from the SharePoint. 
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4.8 Export Report 

Click  button in the toolbar to export report data. Export Options dialog will be 

displayed as shown below: 

 

1) Select or enter a valid export path, where the report should be stored.  

2) Enter a valid file name for the report to be stored.  

3) Select a file type / file format for the export file. If the file type is 'MDB', you can 

additionally specify the table name.  

4) Click OK button to save the report in the specified path. 

 

 

 

 

 

 

 

 

 

 

 

 



CHAPTER 4–Quick Reports 

 

 

4.9 Publish Report 

Click  button in the toolbar to publish the report to a SharePoint Library. Publish 

dialog will be displayed as shown below: 

 

1) Enter a file name for the report to be published.  

2) Select a SharePoint library or folder location, where the report should be 

published.  

3) Select a file format in which report should be published. If the publish type is 

'MDB', you can additionally specify the table name.  

4) Select a report existence check option as required.  

5) Click Publish button to publish the report to a SharePoint library or folder or 

Click Cancel to cancel the operation. 
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4.10  Print Report 

Preview & Print report 

Click  the button in the toolbar to preview and print reports. This will bring up 

the report viewer and will be displayed as shown below. 

 

1) Click the Navigation buttons   to navigate through the 

report pages. 

2) Click the Stop Rendering button  to stop report rendering the report. 

3) Click the Refresh button  to reprocess the report and reload the data from 

the cache. 

4) Click the Print button  to print the report.    

5) Click the Print Layout button  to toggle between the print preview and the 

report viewer page. 

6) Click the Page Setup button  to change the print parameters of the page 

layout. 

7) Select the Zoom control  to enlarge or shrink the view size of 

the report. 
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8) Click the Find button  to find specific text within a report. The search is 

case-insensitive and begins at the page that is currently selected. Wildcards and 

Boolean search operators are not supported. 

9) Click the Next button  to search for subsequent occurrences of the same 

search field value. 

10) Click the Export button  to export the report data in HTML, CSV, MDB, 

PDF, XLS and TIFF file formats. 

11) Click the Report Settings button  to control the appearance of 

the report data. Or Press Alt + S 

 

To modify the Column Settings: 

Column width: The width of the report column can be increased up to a maximum of 

10 inches (default 2 inches for all columns). Specify the values in the Column width text 

box to display the report columns with the specified column width. 
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Merge repeated Cells: Select the  checkbox to enable cell merging 

for the currently selected column. This option enables the data in the specified column to 

be merged together if its rows are repeated with same values. 

Apply to all columns: Click the  button to apply the settings of the 

currently selected column to all the available report columns. By using this, the width 

and cell merging settings of the currently selected column can be applied to all other 

columns. 

Sorting: You can interactively change the sort order while viewing a report by clicking 

the icon (located next to the column header name) to sort them in ascending or 

descending order. 

NOTE: The interactive sort done using the  icon is only for interactive viewing 

purposes and will not be reflected in the exported data.  In order to "export" the data in 

a particular sorted order, you must instead use the report settings   

checkbox to regenerate the report with the specified sort direction for that column.    

To modify the Table column header settings: 

Select the  checkbox to display table header rows on 

each page on which the table appears. 

Select the  checkbox to use a fixed header with 

the table. When you choose this option, the table header remains visible on the screen 

while the user scrolls down the page. 

Showing and hiding the Report columns: 

Click Show/Hide Columns button   to select/remove the columns to 

view and export them. 
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Report Headers: 

Select the  tab to view and edit the report sub-headers for the current report 

data. 
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4.11  E-mail Report 

Click  button in the toolbar to e-mail the report to e-mail recipients. E-mail dialog 

will be displayed as shown below: 

 

ARKSP provides the option to e-mail the reports generated using Quick Reports. For e-

mailing reports, ARKSP requires SMTP Server, From E-mail Address, To E-mail Addresses 

(recipients separated by semicolon) and the report attachment format. 

ARKSP provides check name feature for recipient‟s name. To check name, Click   

button. If name matches with trusted domain users in the Active directory, name 

entered in From address text box will be replaced by corresponding active directory user. 

If there is no match for the name entered by the user in Active Directory, a dialog will 

appear as shown below: 
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Select Delete option in the above dialog to remove the recipient name from To address 

text box. Click Cancel button to close this dialog and the unresolved recipient(s) will 

appear in red color. 

Click Send button to send the report by e-mail to the selected recipients. 
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5 Power Reports 

 

5.1 About Power Reports 

ARKSP provides an offline report generation tool called Power Reports. Power Reports 

tool allows the user to select multiple reports to be run for several SharePoint entities 

(namely, web applications, sites and lists), with powerful data filter options and finally 

run the reports at scheduled intervals. The Power Reports tool has the ability to export, 

publish, and print the reports to different network locations. 

ARKSP Power Reports Wizard will help you create and store the settings for a task in the 

Power Reports Task Manager. The scheduled task will take the schedule settings 

(Schedule Type, Run As parameter) provided using the ARKSP Power Reports Wizard. 

The task will not run unless a valid password is specified for the Run As parameter. 

Please note the following information prior to using the Power Reports Wizard: 

a) The report that is scheduled will be created as a task in Windows Task Scheduler. 

The Schedule Manager allows you to export / publish the reports in different file 

formats (MDB, CSV, HTML, PDF, TIFF and XLS) to the desired path/location 

and/or print the scheduled reports.  

b) The export option follows the naming convention: <<export path>>\<<task 

name>>\<<report generated date and time>>\<<report name>>  

c) For each file format (MDB / HTML / CSV / XLS / TIFF / PDF), a separate file will 

be created based on report category. For example, in MDB file format, for each 

report category an MDB file will be created. 
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5.2 Task Manager- Power Reports Task Manager   

The Power Reports Task Manager allows you to perform the following operations: 

   Create a new task  

   Edit an existing task  

   Copy an existing task  

   Delete a task  

   Run the task immediately  

   Cleanup task history  

   Task Activity View shows the activity of each scheduled instance. 

Click  or Select 

  

Or press CTRL+M to open the Task Manager window. 
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Task Manager User Interface 

 

Task List Pane - Lists the tasks created by ARKSP. You can view the task details when 

you select / highlight a task. 

 

Report Settings Pane - This pane shows the report settings for the selected task. 
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History Details Pane - The task history summarizes the scheduled invocation instances 

of the selected task in a table format. You can refer the 'Task Activity View' to view the 

details of a specific task schedule instance. You can view the errors in the log file listed 

in the 'View Log' field. 
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Schedule Properties Pane - Task Manager shows the schedule properties of the 

selected task. 

 

Actions Pane - Enables you to perform operations on Tasks. Actions pane is visible by 

default. You can close it while you do not want to do any operations on the task. 

Click Power Reports > Show Actions Pane from the tool bar or select Tools > 

Power Reports > Show Actions Pane from menu bar or press CTRL+H to activate 

the actions pane. 
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5.3 New Task  

Click New from Actions Pane or press ALT+N to open the New Task dialog.   

New Task dialog is shown below:    

 

Specify the name and Schedule the task. Click Add to add reports to the task. 
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Step 1: Report Selection page 

 

a) Select the required report to add. You can view a short description and the fields 

for the selected report in the right panel.  

b) Click Next to proceed to the next step. Click Back anytime to go back to a 

previous step.      

Step 2: Scope and URL page  

This step is applicable for all the site and list category reports. This step is not applicable 

for few reports under web application category. Perform the following steps in this 

screen: 

a) Select the Scope and specify the target URL. You can use the Browse dialog or 

type the URL directly and Click the Add button. Browse dialog shows the tree 

nodes based on the selected Scope. You can view them through their title or 

name.  

b) Click Edit button to edit the selected scope and Click Remove to remove the 

selected URL from the list.  

c) Click Next to proceed to the next step. 
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NOTE: Browse dialog shows the SharePoint tree nodes based on the selected scope. 

For the case of 'Connected Web Application only' and 'All Sites in Web Application‟, it 

allows you to select a SharePoint web Application only. For the case of 'Connected Site 

only‟, 'Connected site and it's sub sites', ' All lists in the connected site' and ' All lists in 

the connected site and it's sub sites', it allows you to select a SharePoint site only. For 

the case of 'Connected list only', it allows you to select a SharePoint list only. A sample 

browse dialog is as shown below: 
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'Scope and URL' dialog is report specific. The table given below summarizes the various 

applicable scopes for each report category and a brief description. The data intensive 

reports under each report category may have a few scopes grayed out. 

Report Category Report Scope Description 

Web Application 

Reports 

Connected web application only Retrieves report 

information for the 

connected web application 

only 

All web applications Retrieves report 

information for all web 

applications in the 

SharePoint server 

Site Reports All sites in web application Retrieves report 

information for all the 

sites, including sub-sites 

and  top level sites in the 

web application 

Connected site and its sub-sites Retrieves report 

information for the 

connected site and its sub-

sites 

Connected site only Retrieves report 

information for the 

connected site only 
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List Reports All lists in the connected site and its 

sub-sites 

Retrieves report 

information for all the lists 

in the connected site and 

its sub-sites 

All lists in the connected site Retrieves report 

information for the all the 

lists in the connected site 

Connected list only Retrieves report 

information for the 

connected list only 

Apply to option is used to apply the same scope and URL to selected reports under the 

same report category. For example, if the current report refers the site category, then all 

the selected site category reports are appended with the specified scope and URL 

settings. Click Edit on Scope and URL page to edit the scope. 

 

Click Apply to, to apply the same URL and scope setting to all the selected reports 

under the same category. Click OK to return to the Scope and URL step. 
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Step 3: Specify Report Criteria  

This step allows you to apply specific conditions for filtering report data. 

 

Click Edit to create a data filter. You can also specify the Group By field and number of 

days through the filter criteria dialog. 
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Specify the criteria to filter the report data. 

I. Choose a field name from the dropdown, select an operator and specify the filter 

data.  

NOTE: Operators include special operators called “contains” and "does not 

contains". "Contains" determines whether or not a given character string matches 

a specified pattern. The operator “does not contain” performs the reverse function 

of the “contains” operator.  

 

 

 

 

 

 

 

 



CHAPTER 5 – Power Reports 

63 

II. Click Add to Filter. The selected condition will be added to the criteria list and 

will be displayed as shown below: 

 

III. Use “AND to Filter” and “OR to Filter” , parenthesis (, ) etc., to build an enhanced 

filter condition as shown in the example below: 

[Web Title] Starts with „Sample‟ OR [Web Title] Ends With 'SharePoint' 

IV. Click Apply To, to apply the same criteria for various URLs within the same 

report category and report. 

V. Click OK in Criteria dialog to go back to the reports wizard. 
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The applied criteria will be added to the report as shown below: 

 

Click Next to proceed to the next step. 
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Step 4: Specify delivery options (Export, Publish, E-mail and Print settings) 

This dialog allows you to choose one or more report delivery options. 

a) Export Option: Change the Export path and export file format as necessary. 

 

b) Publish Option: Select Publish check box and specify a valid SharePoint 

library/folder URL. Choose a format and a file existence check option as required. 
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c) E-mail Option: Change the To address and report file format as necessary. 

 

Click Customize to specify subject, body of the e-mail message, option to zip the report 

as attachment. 
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d) Print Setting: Select Print check box and choose a printer from the available list. 

 

You can use the Apply to option to apply the specified settings in this step to all the 

selected reports. 

Click next, to proceed to the next step. 

Step 5: Specify File Settings 

By default, ARKSP will export each report for every single selected URL into a new file. 

File Settings step displays different file name mask options (namely, Web Application 

Name, Site Name, List Name, Parent Site Name, Report Name, Date and Time Stamp) 

for each report. You can choose the desired file name mask from the list and customize 

the export file name. 
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You can use the file name mask options as described below: 

Report Category: Web Application   

File Name Mask Options Selected File Name Mask Result 

ReportName 

WebApplicationName  

DateandTimeStamp 

<ReportName> 

<WebApplicationName> 

Blocked File Types Share 

Point – 9000.html 

<WebApplicationName> 

<DateandTimeStamp> 

<ReportName> 

Share Point – 9000 

201010105-113750 

Content Databases.csv 

 

 

  

 

 



CHAPTER 5 – Power Reports 

69 

Report Category: Site    

File Name Mask Options Selected File Name Mask Result 

ReportName  

SiteName  

ParentSiteName  

WebApplicationName  

DateandTimeStamp 

<WebApplicationName> 

<ReportName> 

Share Point – 9000 Site 

Features.pdf   

<ParentSiteName> 

<SiteName> 

<WebApplicationName> 

<ReportName> 

First Site, Coll First Site, 

Site Features.html 

<ReportName> 

<SiteName> 

<ParentSiteName> 

<WebApplicationName> 

Site Features Share Point 

– 9000.csv 

 

Report Category: List    

File Name Mask Options Selected File Name Mask Result 

ReportName  

ListName  

SiteName  

ParentSiteName  

DateandTimeStamp 

<ReportName> 

<ListName> <SiteName> 

<ParentSiteName> 

File Types Shared 

Documents First Site First 

Site Coll.pdf 

<ListName> <SiteName> 

<ReportName> 

First Site File Types.html 

<SiteName> 

<ParentSiteName> 

<ListName> 

<ReportName> 

First Site Coll File 

Types.html 

You can use the Apply to option to apply the specified settings in this step to all the 

selected reports. 

Click Next to proceed to the next and final step of adding reports. 
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Step 6: Report Summary 

This step displays the summary information for each report. 

 

Click Finish to complete the reports wizard. 

This will take you back to the New Task screen with the task name and the selected 

reports. Specify the schedule Settings for this task to run, and then Click OK to create 

the task. 
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You can see the new task properties in Task Manager window. 
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5.4 Edit Task 

1) Select a task from the Power Reports Task Manager Window and Click Edit from 

the Actions Pane. 

2) Perform the steps 1 through 6 as in New Task. During this process, you may 

change the settings, add a new report, delete a report, edit a report, change the 

export path etc. 

3) The new settings will be used when the task runs the next time. 

5.5 Copy Task 

You can copy an existing task in the Power Reports Task Manager to create a new task 

with the same properties. You may then edit the properties of the newly created task. To 

Copy a task from the existing task list: 

1) Select a task to be copied 

2) Click Copy from Actions Pane. 

3) The Copy Task window will be displayed as shown below: 

 

4) Enter a new task name, and specify the Run As account and password for the 

user context. 

 

5) Click OK 

The newly created task will be added to the Power Reports Task Manager. 



CHAPTER 5 – Power Reports 

73 

5.6 Delete Task 

To delete a task from the Power Reports Task Manager Window, select the task and Click 

Delete from the Actions Pane. The deleted task will also be removed permanently from 

the Task Manager. This action will also delete the tasks created in Windows Task 

Scheduler and all sub-folders & files in the respective task folder. 

5.7 Create Windows Task 

Use this tool to create a Windows Task in Windows Task Scheduler interface to 

automatically run the Power Report tasks at scheduled intervals. 

This tool helps you to re-create the Windows Schedule Task in the following two 

scenarios: 

 To create Windows Schedule Task that was accidentally deleted and is required to 

be created again with the same schedule settings  

 To create Windows Schedule Task when the ARKSP Power Report tasks are 

migrated from an old machine to a new machine 

Click Create Windows Task from Actions Pane or press ALT+W to open the Create 

Windows Task dialog.    
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Create Windows Task dialog is shown below: 

In Create Windows Task dialog, specify a Run As account and Password and Click 

OK to create a new schedule task with the same schedule settings that was previously 

saved by ARKSP Power Report Task Wizard. 
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5.8 Run Now 

Select a task and click Run Now from the Actions Pane to run the task immediately. 

This option enables you to run the selected task with a different user context in every 

task invocation. 

Run Now dialog appears as shown below: 

 

1) Specify user name and password under SharePoint credential to run the task 

temporarily.  

2) Select desired authentication mode by which ARKSP has to connect to the 

specified SQL server.  

3) If SQL authentication mode is selected, enter SQL user name and password. In 

this case, a user profile with the SQL user name and password will be created 

under the Run As account so as to connect to SQL server while the task runs 

under the specified Run As account. Read Profile Manager for more details.  

4) Specify user name and password to run the task temporarily.  

5) Click OK to run the task with the specified user context. 
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5.9 Run a task from command line 

ARKSP command line feature allows the user to instantiate a task from DOS command 

prompt anytime after a Power Reports task has been created using ARKSP Power 

Reports task wizard. 

To run an ARKSP Power Reports task from command line:   

1) Usage 

ARKSPTaskRunner <task name> 

Where,  

ARKSPTaskRunner Name of the ARKSP Task Runner application. Specify absolute 

path where the ARKSP Task Runner located.  

For example: C:\Program Files\ARKSP2010\ARKSPTaskRunner 

Task name  Name of the ARKSP Power Reports task to be run from DOS 

command prompt. Enclose the task name in double quotes. 

For example: "MySite Reports" 

 

2) The Power Reports task will be reported in a new dialog as shown below: 

 

3) Once the task is completed, click Refresh button available in Task History pane in 

ARKSP main application. A new entry will be added in Task History section, where 

you can view the report performed. 
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Examples of invoking a Power Reports task from the command prompt: 

C:\Program Files\ARKSP2010> ARKSPTaskRunner "MySite Reports" 

D:\>"C:\Program Files\ARKSP2010\ARKSPTaskRunner" "MySite Reports" 

DOS batch file examples: 

 To execute Power Reports tasks one by one from a batch file: 

"C:\Program Files\ARKSP2010\ARKSPTaskRunner" "MySite Reports" 

"C:\Program Files\ARKSP2010\ARKSPTaskRunner" "Sample List Reports" 

 To execute multiple Power Reports tasks simultaneously: 

Start "cmd" "C:\Program Files\ARKSP2010\ARKSPTaskRunner" "MySite 

Reports" 

Start "cmd" "C:\Program Files\ARKSP2010\ARKSPTaskRunner" "Sample List 

Reports" 
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5.10   Task Activity View   

Task Activity View shows you the full task details, including start, end and elapsed time 

for the task to run, SharePoint reports that were run along with its report status and also 

a hyperlink to view the report from the exported path. 

Perform the following steps to view the task activity: 

1) Select a task instance from the Task History pane table.  

2) Click Task Activity View menu item in the Actions pane. 

 

Click Export button to export the table contents to a file. 

The Settings tab shows the settings for the selected report that are provided by the 

user. 
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5.11  Cleanup History  

ARKSP maintains task history including log files and temporary data for each run of the 

Power Reports task. You can cleanup task history periodically using the Cleanup 

History from Actions Pane 
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Chapter 

6 
6 Custom Reports 

6.1 Custom Reports Manager  

Custom Reports Manager allows the user to manage the custom reports available in the 

application. A custom report can be created by selecting a set of fields from a quick 

report and save them as a custom report template for re-use. It also enables storing of 

criteria for a custom report. The Custom Reports Manager allows the user to create, edit, 

copy and delete custom reports.   

Click    in the toolbar or select Tools > Custom Reports from the menu 

bar or press CTRL + U to open the Custom Reports Manager. 

Custom Reports Manager window will be displayed as shown below 
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New Custom Report 

Click new button in Custom Reports Manager or press ALT+N to open the Custom 

Reports Wizard.   

Perform the following steps to create a new custom report: 

Step 1: Report Selection page 

 

a) Select the required report to be used as template. You can view a short 

description and the fields for the selected report in the right pane.  

b) Click Next to proceed to the next step. Click Back anytime to go back to a 

previous step.  
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Step 2: Fields Selection page 

This step allows you to select the required fields from the report fields. 

 

Perform the following steps in this dialog: 

a) Select the required field(s) to add. You can use   to add a field to the selected 

fields list and    to remove a field from the selected fields list.  

b) Select a field from the selected fields list and click   or   to move the field 

one position up or down. Also click   or   to move the field to the first or 

last position in the field list.  

c) Click Next to proceed to the next step. Click Back anytime to go back to a 

previous step.   
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Step 3: Specify Report Criteria 

This step allows you to apply specific conditions for filtering report data. 
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Click Edit to create a data filter. Criteria dialog will be displayed as shown below: 

 

Perform the following steps in this dialog to specify the report criteria:   

a) Choose a field name from the dropdown, select an operator and specify the filter 

data. 

NOTE: Operators include a special operator called “contains” and "does not 

contain". "Contains" determines whether or not a given character string matches 

a specified pattern. The operator “does not contain” performs the reverse function 

of the “contains” operator. 
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b) Click Add to Filter. The selected condition will be added to the criteria list and 

will be displayed as shown below: 

 

c) Use “AND to Filter” and “OR to Filter” , parenthesis (, ) etc., to build an enhanced 

filter condition as shown in the example below: 

[Web Application] Contains „Test‟ OR [Created Date] >= #07/01/08 12:00:00 

AM#   

d) Click OK in Criteria dialog to go back to the criteria page. 
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The added criteria will be applied to the report as shown below: 

 

Click Next to proceed to the next step. 
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Step 4: Report Summary  

This step displays the summary information for the selected report. 

 

1) Specify unique name and description for the custom report.  

2) Click Finish to save the new report and close the custom reports wizard.   

 

 

 

 

 

 

 

 

 



CHAPTER 6 – Custom Reports 

88 

You can view the newly created custom report and its settings in Custom Reports 

Manager window as shown below: 

 

Edit a Custom Report 

This feature allows you to edit an existing custom report. 

1) Select the custom report you want to edit.  

2) Click Edit button.   

3) Edit the report fields and criteria. You cannot change the report name, but the 

description is editable.  

4) Click Finish to save the report settings. 

During edit, you can also apply the modified criteria of a custom report to Power Reports 

tasks that uses this updated custom report. Upon clicking Finish after editing a report, 

'Apply to' dialog showing the list of tasks and URL will be displayed as shown below 
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1) Select the tasks and URLs for which you want to update the report criteria.  

2) Click OK to apply the current criteria to the selected URLs.   
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Copy a Custom Report 

 Select the Custom Report you want to copy.  

 Click Copy button. Copy Custom Report dialog will be shown as below. 

 

 Enter a valid name and description for the report.  

 Click OK to create a new custom report with the source report settings. 

Delete a Custom Report 

1) Select the Custom Report you want to delete.  

2) Ensure that the custom report you want to delete is not currently in use in any of 

the Power Reports tasks.  

3) Click Delete button to delete the selected report. 
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6.2 New Custom Report   

Click New button in Custom Reports Manager or press ALT+N to open the Custom 

Reports Wizard.   

Perform the following steps to create a new custom report: 

Step 1: Report Selection page 

 

a) Select the required report to be used as template. You can view a short 

description and the fields for the selected report in the right pane.  

b) Click Next to proceed to the next step. Click Back anytime to go back to a 

previous step.    
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Step 2: Fields Selection page 

This step allows you to select the required fields from the report fields. 

 

Perform the following steps in this dialog: 

a) Select the required field(s) to add. You can use   to add a field to the selected 

fields list and    to remove a field from the selected fields list.  

b) Select a field from the selected fields list and click   or   to move the field 

one position up or down. Also click   or   to move the field to the first or 

last position in the field list.  

c) Click Next to proceed to the next step. Click Back anytime to go back to a 

previous step. 
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Step 3: Specify Report Criteria 

This step allows you to apply specific conditions for filtering report data. 
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Click Edit to create a data filter. Criteria dialog will be displayed as shown below: 

 

Perform the following steps in this dialog to specify the report criteria:   

a) Choose a field name from the dropdown, select an operator and specify the filter 

data. 

NOTE: Operators include a special operator called “contains” and "does not 

contain". "Contains" determines whether or not a given character string matches 

a specified pattern. The operator “does not contain” performs the reverse function 

of the “contains” operator. 
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b) Click Add to Filter. The selected condition will be added to the criteria list and 

will be displayed as shown below: 

 

c) Use “AND to Filter” and “OR to Filter” , parenthesis (, ) etc., to build an enhanced 

filter condition as shown in the example below: 

Web Application] Contains „Test‟ OR [Created Date] >= #07/01/08 12:00:00 

AM#   

d) Click OK in Criteria dialog to go back to the criteria page. 
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The added criteria will be applied to the report as shown below: 

 

Click Next to proceed to the next step. 
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Step 4: Report Summary 

This step displays the summary information for the selected report. 

 

1) Specify unique name and description for the custom report.  

2) Click Finish to save the new report and close the custom reports wizard.   
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You can view the newly created custom report and its settings in Custom Reports 

Manager window as shown below: 
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7 
7 References 

7.1 Alert Messages 

1)  

 

a) Check the URL format (e.g., http://server name:port number/sitename)  

b) Check the server instance.  

c) Spell check the URL 

 

2)  

ARKSP shows the above alert, if the currently logged on user does not have 

sufficient permissions to retrieve the site or list information in SharePoint. Please 

ensure the currently logged on user has 'View Pages', 'Browse Directories' and 

'Manage Lists' rights in the connected site. 

3)  
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ARKSP shows the above alert when it encounters any errors while generating a 

report. Click View button to view the errors and the possible resolution. Check 'Do 

not show this message again' checkbox to turn-off the alert. You can turn-on the 

alert messages again from the Tools menu. You may also view the errors in a 

report by clicking on the 'Error' button in the bottom status bar of ARKSP 

application. 

4)  

While generating the 'Page Visits', 'List Visits' and 'Last Deleted Items' reports the 

above alert window will appear when the logging is disabled in IIS. 

5)  

'Page Hits', 'Site Hits Summary', 'Site Visitors' and 'List Hits' reports requires STS 

logging to be enabled to generate the report. Enable the "Enable Logging" and 

"Enable usage analysis processing" options in the "Usage Analysis Processing" 

section in the SharePoint Central Administration. 

6)  

ARKSP shows the above alert when the audit settings are not configured for the 

selected audit report event.  
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7)  

ARKSP shows the above alert, if the currently logged on user does not have 

sufficient permissions to retrieve the web applications information in SharePoint. 

The currently logged on user must be an application pool identity account or must 

be a member of local Administrators group in the SharePoint server and database 

server. 

8)  

If the web application URL is valid, please ensure the currently logged on user has 

sufficient rights to access the web application. The currently logged on user must 

be an application pool identity account or must be a member of local 

Administrators group in the SharePoint server and database server. 

9)  

If the site URL is valid, please ensure the currently logged on user has 'View 

Pages' and 'Browse Directories' rights in the respective site. Also, the currently 

logged on user must be an application pool identity account or must be a member 

of local Administrators group in the SharePoint server and database server. 
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10)  

If the list URL is valid, please ensure the currently logged on user has 'View Pages' 

and 'Browse Directories' rights in the respective site where the list resides. Also, 

the currently logged on user must be an application pool identity account or must 

be a member of local Administrators group in the SharePoint server and database 

server. 

11)  

If the list URL is valid, please ensure the currently logged on user has 'View Pages' 

and 'Browse Directories' rights in the respective site where the list resides. Also, 

the currently logged on user must be an application pool identity account or must 

be a member of local Administrators group in the SharePoint server and database 

server. 

12)  

It is preferable to run ARKSP using an application pool identity account or a user 

account that is a member of local Administrators group in the SharePoint server 

and database server. 
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13)  

ARKSP shows this alert when the user tries to publish the report to a SharePoint 

library. Please ensure the library URL is valid and the user account has access to 

the document library and the folder location where the report is to be published. 
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7.2 Troubleshooting  

Troubleshoot a problem 

While using ARKSP, if and when a problem arises, please forward the following 

information to support@vyapin.com to revert back to you with a solution. 

1) Version of ARKSP you are evaluating or you have registered with us (version 

information could be found in "About" screen and in "Help") 

2) Additional services or resource consuming processes/applications (like anti-virus, 

indexing) running in the background on the computer where ARKSP is installed. 

3) Hardware configuration of ARKSP installed computer. 

4) 'Service Pack' version of Microsoft SharePoint Server 2010 / Windows OS 

running currently. 

5) Send us the "Error Log" (ARKSPErrorLog.txt) available in the "<Application Data 

Folder>\ARKSP2010\Log" 

folder.(e.g.,C:\Users\Public\Documents\ARKSP2010\Log\ARKSPErrorLog.txt) 

6) For Power Reports issues, send also the ARKSPErrorLog.txt available in the 

<Application Data Folder>\ARKSP2010\Power Reports\<<Task Name>>\<<Date 

and Time Stamp>> folder. 

The <Application Data Folder> is the common location where ARKSP tasks and 

task history will be stored in the computer running ARKSP application. The 

<Application Data Folder> can be found from Help -> About screen. The default 

path of <Application Data Folder> is as follows: 

 

 Windows 2008  - C:\Users\Public\Documents 

 

 

7.3 Technical Support 

Technical support is available through e-mail.  

Send your questions to support@vyapin.com. 

We make every effort to respond to your request on the same day you send in your e-

mail.  

Please allow up to 24 hours for our technical support team to revert back to you. 
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7.4 How to Uninstall ARKSP? 

When you create Power Report tasks in ARKSP, the application creates Windows 

Scheduled Tasks (to run the Power Report tasks at the specified time interval) where 

ARKSP is installed. While running the Quick Reports or Power Report task, ARKSP creates 

ARKSPSettings folder to store the application settings, Log folder to store error log file, 

Export folder for exported reports, Power Reports folder for Power Reports task related 

information, SQL Server database for data storage. 

When you uninstall ARKSP through Control Panel - Add / Remove Programs applet, 

Windows Installer program will remove only the application files from your machine. But, 

the application related files created by ARKSP remain in the computer. In order to 

remove ARKSP worker files completely, the uninstall wizard provides a set of cleanup 

options to perform the cleanup operation based your selection. 

Use this wizard to cleanup the files that are created by Admin Report Kit for SharePoint 

2010 application selectively and uninstall ARKSP completely from the machine. 

1) Launch the uninstall wizard by clicking Start -> Programs -> Admin Report Kit  

for SharePoint 2010 -> ARKSP Uninstall Wizard. 

The ARKSP Uninstall Wizard dialog will be shown as below:  

 

Click Next to proceed. 
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2) Select required cleanup options as shown below: 

Click Next to proceed. 

3) Confirm the cleanup and/or uninstall process. 

 

Click Finish to run cleanup and/or uninstall process. Click Cancel to close the wizard. 
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4) Once the file cleanup process is complete, the uninstall wizard will automatically 

run Windows Installer program to remove ARKSP application from the machine, 

if you have selected the cleanup option Uninstall ARKSP application in the 

wizard. 
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